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Introduction

This user's manual describes how to conduct the "I-V characteristics Test", "Cole-Cole Plot", and
"Constant Current Test" by using the application software "FC Tester for KFM2005".

■ Product versions that this manual covers
This user's manual applies to FCTester for KFM2005 with version 1.0x.

You can check the version from the help menu About.

■ Required versions for the KFM2005
The KFM2005 with firmware version 1.0x is required. The version appears on the LCD when the
KFM2005 is turned on.

■ Intended readers of this manual
This user's manual is intended for anyone using the KFM2005 to test a fuel cell or anyone teaching
operators how to use the product.

This manual assumes that the reader has knowledge about electronic measuring instrument.

■ Trademarks
Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.

Other company names and product names that appear in this manual are trademarks or registered
trademarks of their respective companies.

■ Notations used in this manual

• The KFM2005 FC Impedance Meter may be called the KFM2005.

• "Personal computer" and "PC" are generic terms for personal computers and workstations.

• The following symbols are used with the explanations in this manual.

This symbol indicates a potentially hazardous situation. Ignoring the symbol may 
result in damage to the product or other property.

Indicates information that you should know.

CAUTION
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What is FCTester for KFM2005?

The application software "FC Tester for KFM2005" controls the KFM2005 by the PC, and conduct
such fuel cell testing's. This software "FC Tester for KFM2005" can perform the following features.

● I-V characteristics test

It acquires the I-V (Load current - Cell voltage) characteristics by varying the load current in steps. At
the same time, it measures the impedance of the cell at the specific frequency.

● Cole-Cole plot

It measures the impedance and creates the Cole-Cole plot by varying the frequency of the
superimposed current while the specific load current is drawn by the fuel cell.

● Constant current test

The data logging for the cell voltage and impedance while the specific load current is drawn by the
fuel cell.

● Saving the test result

The test result can be saved as a text file. The saved file can be used by other application software.
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Connecting the KFM2005

When activating the "FCTester for KFM2005", the KFM2005 is in the status of "unconnected". To start
testing, a manual operation is required to recognize for the connection between the KFM2005 and
the "FCTester for KFM2005".

1 Select Setup on the Options menu.

p. 22 2 Select the communication interface corresponded to the VISA Resoure Name of
the Connected Instrument.

3 Click Connect.
If the Status is not changed even when you click connect, and the error message is displayed,
please follow the step as follows.

When the KFM2005 can not be connected

If the Status is not changed even when you click Connect, and the error message is displayed,
please follow the step as follows.

1 Confirm that the POWER switch of the KFM2005 is turned on.

2 Confirm that the communication interface cable between the KFM2005 and the
PC are properly connected.

3 Confirm that the communication interface of the KFM2005 has been properly
selected.
After the "Interface Menu" is displayed by pressing the SYSTEM key, you can check the status by
pressing the F1 key. For details, see "Remote Control" in the KFM2005 User's Manual.

The connection can not be recognized if the selected communication interface of the KFM2005 
were not corresponded to the VISA Resource Name of the Connected Instrument of the 
"FCTester for KFM2005".

See

Click



6 FCTester for KFM2005

I-V Characteristics Test

Click the I-V Characteristics tab.

The I-V characteristics test is to measure the cell voltage by varying the load current IL in steps
(current sweep) from the start current to the turn current and until the stop current.

When the start current is set to 0 A, the turn current to 5 A, and the stop current to 0 A, the load
current IL will be shown as follows.

If the setting of the turn current and the stop current is the same, the test will be stopped when the
current reaches the turn current.

To sweep the load current, the setting for the amount of change per step (step current) and the
time interval ( T) are required.

Load current IL

Cell voltage
Vc

Start current/Stop current Turn current

IL Increase

IL Decrease

0 A 5 A

Δ
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I-V Characteristics Test

When it is set for the start current at 0 A, step current at 0.1 A, and the time interval at 5 s, the load
current setting and the measurement point of the cell voltage will be as follows.

The voltage is measured just before the next value of the load current to be set.

Starting a Test

Before starting a I-V characteristics test, check the result file storage setting.

p. 22 1 Specify the Result File Storage option.

p. 8, p. 7 2 Set the measurement conditions.
See Measurement Condition Settings and Impedance Measurement Time.

3 Set the graph scale.

p. 9, p. 24
See Graph Scale Settings.
To set the graph display option, point to graph from the option menu.

4 Click Start.

p. 9
When the test starts, the Status Display changes into Executing and ON.
To stop the test, click Stop.

Impedance Measurement Time

The approximate time for the impedance measurement S can be expressed by the following
formula.

Set the time interval T for longer than the setting time of the impedance measurement S.

 Impedance measurement S < Time interval T

(Example) When it is set for the Frequency at 0.1 Hz, the Integral average count for 4 times, and the
Moving average count for 2 times.

The time for the impedance measurement takes (0.8  + 10 X 4) X 2 = 81.6 seconds. 

When it is set for the time interval T at less than 81.6 seconds, the load current will be
changed before the completion of the impedance measurement. Set the time interval T with
extra allowance.

0 A

5 s 5 s 5 s

0.1 A

0.2 Aa1

ax: Current setting
bx: Voltage measurement

a2

b1

a3

b2

b3

See

See

See

See

 = (0.8 +        ×                              ) × 1
Frequency f

Impedance measurement
time S

Integral average
count

Moving average
count

Δ
Δ

Δ
Δ
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I-V Characteristics Test

Measurement Condition Settings

p. 23
*1 In the Setup dialog box on the Options menu, you can select "Load Off at 0 (A)" for the

load current IL.
*2 For details, see "Specifications" in the KFM2005 User's Manual.

Item Description

Load Current IL Settings*1

Range Selects the range of load current from 0.5 A or 5 A.

Start Current Sets the start current of the current sweep.
Input range: 0.00000 A to 0.50000 A (0.5 A range)
                       : 0.0000 A to 5.0000 A (5 A range)

Turn Current Sets the turn current of the current sweep. If the difference with the start current is not 
divisible by the step current, the current may not reach the specified value.
Input range: 0.00000 A to 0.50000 A (0.5 A range)
                       : 0.0000 A to 5.0000 A (5 A range)

Stop Current Sets the stop current of the current sweep.
Input range: 0.00000 A to 0.50000 A (0.5 A range)
                       : 0.0000 A to 5.0000 A (5 A range)

Step Current Sets the amount of change per step.
Input range: 0.00000 A to 0.50000 A (0.5 A range)
                       : 0.0000 A to 5.0000 A (5 A range)

Time Interval Sets the time per step.
Input range:  1 s to 9999 s  (an error of ±1 s)

Repeat Count Sets the repeat count of the sweep (start to turn to stop).
Input range:  1 to 9999 times, or infinity

Start button Starts the current sweep.

Stop button Stops the current sweep.

Impedance Settings

Frequency f Sets the frequency at which impedance is measured.
Input range:  0.01 Hz to 10000 Hz (only the specified 85 points*2)

Range Sets the full scale range of the impedance measurement.
Input range: 100 m , 300 m , 1000 m , or AUTO (superimposed current 50 mA)
                       : 300 m , 1000 m , 3000 m , or AUTO (superimposed current 16.5 mA)

Moving Average Sets the moving average count of the impedance measurement.
Input range:  1, 2, 4, 8, 16, 32, 64, 128, or 256 times

Integral Sets the integral average count of the impedance measurement.
Input range:  1, 2, 4, 8, 16, or 32 times

Superposed Current Sets the superimposed current.
Input range:  16.5 mA, 50 mA, or OFF

FIX Fixes the value of superimposed current.

AUTO To keep the terminal voltage of the DUT at 5 mVpp, it varies automatically between 
the range from 10 % to 100 % of the value in selected range of the superimposed 
current.

MANUAL Sets the value ratio (%) for the superimposed current of the selected range.
Input range:  10 %  to  100 %

Stop Condition Settings

Enable Load Off 
Voltage

Selects either to perform or not to perform the automatic stop when it goes under the 
cell voltage Vc.

Off Voltage Sets the voltage at which the test is automatically stopped.
Input range:  0.000 V to 20.000 V

Ω Ω Ω
Ω Ω Ω

See



FCTester for KFM2005 9

I-V Characteristics Test

Graph Scale Settings

Select graphs to display, and adjust the graph scale of the measured values.

You can enter the Minimum and Maximum values in the combo boxes.

Monitor (Measured Values Display)

Load current IL and voltage Vc are displayed at approximately 2-second intervals.

Resistance R, reactance jX, impedance IZI, and phase angle  are displayed at the time interval ( T).

Status Display

The Load Current indicates the execution status of test.

The Impedance indicates the status of impedance measurement.

You can double-click the status box to open the Alarm Information dialog box.

*1 Load current status only
*2 Impedance status only

You can change these values even while the test is in progress (load on). However, avoid doing so as 
it places a heavy load on the PC.

θ Δ

Status Description

Not connected  FCTester for KFM2005 is started. (yellow)

Standby*1 A test is executable. (gray) 

Executing*1 A test is in progress. (green) 

Stopped*1 The stop button is pressed. (gray)

End*1 A test is completed. (gray)

Voltage stop The test stops at the off voltage. (yellow)

Error Communication error, etc. (red)

Load error An error occurs at the electronic load unit. (red)

OFF*2 Impedance measurement is off. (gray) 

ON*2 Impedance measurement is on. (green) 

Not measurable Measurements cannot be made due to over range, etc. 
(yellow)
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I-V Characteristics Test

Result File

The result file (the I-V Characteristics Test file) will be saved in the designated file.

p. 22
When the Auto Save is selected for the Result File Storage option, the name of file will be
"IV"+"Date"+"Time".

The data can be created in the text format by the TSV (Tab Separated Value).

When you select Open on the File menu and specify the I-V Characteristics Test file , the graph will
be displayed with the  condition of measurement setting.

See

Measurement condition 

Measured data
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Cole-Cole Plot

Click the Cole-Cole Plot tab.

To create the Cole-Cole plot, the impedance measurement will be executed when the load current
IL reaches the setting value while gradually increasing the load current to the fuel cell. The
impedance will be measured by varying the frequency of superimposed current (frequency sweep)
from the start frequency f1 to the stop frequency f2. When you restart the measurement at the time
of completion for the measurement  of f2, the new result file will be created. To terminate the Cole-
Cole plot, click the OFF and gradually decrease the load current down to 0 A.

For example, if you set the load current to 2 A, the rise/fall time to 60 s, and click ON, the load
current is gradually increased to 2 A over 60 seconds.

The time interval is approximately 1 s. The step current is equal to 2/60 which is approximately
0.0333 A.

Load current
IL

Rise time The frequency of the superposed 
current is swept from f1 to f2.

Click ON. Click Start. Click OFF.

0 A

Impedance measurement

Fall time
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Cole-Cole Plot

Starting a Plot

Before starting a Cole-Cole plot, check the result file storage setting.

p. 22 1 Specify the Result File Storage option.

p. 13 2 Set the measurement conditions.
See Measurement Condition Settings.

3 Set the graph scale.

p. 14, p. 24
See Graph Scale Settings.
To set the graph display option, point to graph from the option menu.

4 Click ON.

p. 14
The Load current status changes into Rising.

5 After the Load current status changes into ON, Click  Start.
The Impedance status changes into Executing.
To stop the Cole-Cole plot, click Stop.

6 After the Impedance status changes into Stopped, Click  OFF.
If you click Start, a Cole-Cole plot starts again and new result file is created.
If you click OFF, the Load current status changes into Falling. When the load current decreased
to 0 A, the status changes into OFF.

CAUTION When you click the Stop Immediately while the load current is drawn, it makes immediately load 
off and cut off the load current. Pay attention, when you use the Stop Immediately, it may lead to 
destroy the fuel cell.

See

See

See

See
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Cole-Cole Plot

Measurement Condition Settings

p. 23
*1 In the Setup dialog box on the Options menu, you can select "Load Off at 0 (A)" for the

load current IL.
*2 For details, see "Specifications" in the KFM2005 User's Manual.

Item Description

Load Current IL Settings*1

Range Selects the range of load current from 0.5 A or 5 A.

Load Current Sets the load current. Except when the impedance measurement is performed (while 
the frequency sweep), it is possible to set the load current even during the load on 
status. Under the condition of load on status, the load current can be confirmed when 
the value is entered and press the "Enter" key.
Input range: 0.00000 A to 0.50000 A (0.5 A range)
                       : 0.0000 A to 5.0000 A (5 A range)

Rise/Fall Time Sets the rise and fall time to reach the setting value of load current. The step transition 
is the interval of one second. The minimum step can be set in 0.00001A for the "0.5 A" 
range, and 0.0001A for the "5 A" range
Input range:  0 s to 999 s

ON button Increases the load current.

OFF button Decreases the load current.

Stop 
Immediately 
button

Cuts off the load current.

Stop Condition Settings

Enable Load Off 
Voltage

Selects either to perform or not to perform the automatic stop when it goes under the 
cell voltage Vc.

Off Voltage Specifies the voltage at which the test is automatically stopped.
Input range:  0.000 V to 20.000 V

Impedance Settings

Start Frequency 
f1

Sets the frequency at which the frequency sweep starts.
Input range:  0.01 Hz to 10000 Hz (only the specified 85 points*2)

Stop Frequency 
f2

Sets the frequency at which the frequency sweep stops.
Input range:  0.01 Hz to 10000 Hz (only the specified 85 points*2)

Range Sets the full scale range of the impedance measurement.
Input range: 100 m , 300 m , 1000 m , or AUTO (superimposed current 50 mA)
                       : 300 m , 1000 m , 3000 m , or AUTO (superimposed current 16.5 mA)

Moving Average Sets the moving average count of the impedance measurement.
Input range:  1, 2, 4, 8, 16, 32, 64, 128, or 256 times

Integral Sets the integral average count of the impedance measurement.
Input range:  1, 2, 4, 8, 16, or 32 times

Start button Starts the frequency sweep and starts the retrieval of the Cole-Cole plot data.  When 
the frequency sweep completes, the test automatically stops.

Stop button Stops the retrieval of the Cole-Cole plot data.

Superposed Current Sets the superimposed current.
Input range:  16.5 mA, or 50 mA

FIX Fixes the value of superimposed current.

AUTO To keep the terminal voltage of the DUT at 5 mVpp, it varies automatically between 
the range from 10 % to 100 % of the value in selected range of the superimposed 
current.

MANUAL Sets the value ratio (%) for the superimposed current of the selected range.
Input range:  10 %  to  100 %

Ω Ω Ω
Ω Ω Ω

See
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Cole-Cole Plot

Graph Scale Settings

Adjust the R and jX graph scales of the Cole-Cole plot.

You can enter the Minimum and Maximum values in the combo boxes.

Monitor (Measured Values Display)

Load current IL and voltage Vc are displayed at approximately 2-second intervals.

Resistance R, reactance jX, impedance IZI, and phase angle  are synchronized to the impedance
measurement time.

The measurement takes longer for lower frequencies.

Status Display

The Load Current indicates the execution status of test.

The Impedance indicates the status of impedance measurement.

You can double-click the status box to open the Alarm Information dialog box.

*1 Impedance status only
*2 Load current status only

You can change these values even while the impedance measurement is in progress. However, 
avoid doing so as it places a heavy load on the PC.

θ

Status Description

Not connected  FCTester for KFM2005 is started. (yellow)

Standby*1 A impedance is able to measure. (gray) 

Executing*1 A impedance measurement is in progress. (green) 

Stopped*1 The stop button is pressed. (gray)

End*1 A impedance measurement is completed. (gray)

Voltage stop The impedance measurement stops at the off voltage. (yellow)

Error Communication error, etc. (red)

Load error An error occurs at the electronic load unit. (red)

OFF*2 Load current not running. (gray) 

ON*2 Load current running. (green) 

Rising*2 Load current is gradually increasing. (green)

Falling*2 Load current is gradually decreasing. (green)

Not measurable Measurements cannot be made due to over range, etc. (yellow)
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Cole-Cole Plot

 Equivalent Circuit

An equivalent circuit of the fuel cell under test can be calculated backward from the retrieved Cole-
Cole plot data.

Item Description

f Range Indicates the range of the applied data to the specified frequency. By 
default, all the data (f1 to f2) are used. 
This item can be used to exclude +jX data at high frequencies.

Calculate button Calculates the equivalent circuit constants (R1, R2, and C.)

Plot button Draws the ideal circle of the Cole-Cole plot from the calculated constants.
You can type the values into boxes of constants to change the ideal circle.

Clear button Clears the ideal circle of the Cole-Cole plot.

Display to overlay the Cole-Cole plot drawn by 
the equivalent circuit on the measurement data .
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Cole-Cole Plot

Result File

The result file (the Cole-Cole plot file) will be saved in the designated file.

p. 22
When the Auto Save is selected for the Result File Storage option, the name of file will be
"COLE"+"Date"+"Time".

The data can be created in the text format by the TSV (Tab Separated Value).

When you select Open on the File menu and specify the Cole-Cole plot file , the graph and
Equivalent Circuit will be displayed with the  condition of measurement setting.

See

Measurement condition 

Measured data
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Constant Current Test

Click the Constant Current Test tab.

For the constant current test, draw the load current gradually to the fuel cell and keep the load
current when it reaches to the setting amount of value (IL). The impedance will be measured under
the condition of constant current. When the constant current test is finished, gradually decrease the
load current down to 0 A.

For example, if you set the load current to 2 A, the rise/fall time to 60 s, and click Start, the load
current is gradually increased to 2 A over 60 seconds.

The time interval is approximately 1 s. The step current is equal to 2/60 which is approximately
0.0333 A.

Data logging

0 A

Load current
IL

Rise time

Click ON.Click Start. Click Stop.

Impedance measurement Fall time
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Constant Current Test

Starting a Test

Before starting a constant current test, check the result file storage setting.

p. 22 1 Specify the Result File Storage option.

p. 19, p. 18 2 Set the measurement conditions.
See Measurement Condition Settings and Impedance Measurement Time.

3 Set the graph scale.

p. 9, p. 24
See Graph Scale Settings.
To set the graph display option, point to graph from the option menu.

4 Click Start.

p. 20
The Load current status changes into Rising.

5 After the Load current status changes into Executing, Click  ON.
The Impedance status changes into ON.
To stop the constant current test, click Stop.
If you click Stop, the Load current status changes into Falling. When the load current
decreased to 0 A, the status changes into Stopped.

 Impedance Measurement Time

The approximate time for the impedance measurement S can be expressed by the following
formula.

Set the logging interval T for longer than the setting time of the impedance measurement S.

 Impedance measurement S < Logging interval T

When the impedance measurement is not completed during the logging interval period with the
setting of "S > T", the data just prior to the present measurement will be displayed in the graph, and
it will be saved in the file.

CAUTION When you click the Stop Immediately while the load current is drawn, it makes immediately load 
off and cut off the load current. Pay attention, when you use the Stop Immediately, it may lead to 
destroy the fuel cell.

See

See

See

See

 = (0.8 +        ×                              ) × 1
Frequency f

Impedance measurement
time S

Integral average
count

Moving average
count
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Constant Current Test

Measurement Condition Settings

p. 23
*1 In the Setup dialog box on the Options menu, you can select "Load Off at 0 (A)" for the

load current IL.
*2 For details, see "Specifications" in the KFM2005 User's Manual.

Item Description

Load Current IL Settings*1

Range Selects the range of load current from 0.5 A or 5 A.

Load Current Sets the load current. It is possible to set the load current even while the test is in 
progress (load on). During the test, the load current can be confirmed when the value 
is entered and press the "Enter" key.
Input range: 0.00000 A to 0.50000 A (0.5 A range)
                       : 0.0000 A to 5.0000 A (5 A range)

Rise/Fall Time Sets the rise and fall time to reach the setting value of load current. The step transition 
is the interval of one second. The minimum step can be set in 0.00001A for the "0.5 A" 
range, and 0.0001A for the "5 A" range
Input range:  0 s to 999 s 

Start button Starts the data retrieval. The load current is increased.

Stop button Stops the data retrieval. The load current is decreased.

Stop 
Immediately 
button

Stops the data retrieval.  Cuts off the load current.

Stop Condition Settings

Enable Load Off 
Voltage

Selects either to perform or not to perform the automatic stop when it goes under the 
cell voltage Vc.

Off Voltage Specifies the voltage at which the test is automatically stopped.
Input range:  0.000 V to 20.000 V

Maximum Run 
Time

If the elapsed time exceeds this value, the test is completed.
Input range:  1 min to 1440 min, or infinity

Impedance Settings

Frequency f Sets the frequency at which impedance is measured.
Input range:  0.01 Hz to 10000 Hz (only the specified 85 points*2)

Range Sets the full scale range of the impedance measurement.
Input range: 100 m , 300 m , 1000 m , or AUTO (superimposed current 50 mA)
                       : 300 m , 1000 m , 3000 m , or AUTO (superimposed current 16.5 mA)

Moving Average Sets the moving average count of the impedance measurement.
Input range:  1, 2, 4, 8, 16, 32, 64, 128, or 256 times

Integral Sets the integral average count of the impedance measurement.
Input range:  1, 2, 4, 8, 16, or 32 times

ON button Starts the impedance measurement.

OFF button Stops the impedance measurement.

Superposed Current Sets the superimposed current.
Input range:  16.5 mA, or 50 mA

FIX Fixes the value of superimposed current.

AUTO To keep the terminal voltage of the DUT at 5 mVpp, it varies automatically between the 
range from 10 % to 100 % of the value in selected range of the superimposed current.

MANUAL Sets the value ratio (%) for the superimposed current of the selected range.
Input range:  10 %  to  100 %

Sampling

Logging Interval Sets the data retrieval interval. This setting is synchronized to the graph display.
Input range:  1 s to 86400 s (an error of ±1 s)

Ω Ω Ω
Ω Ω Ω

See
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Constant Current Test

Graph Scale Settings

Select graphs to display, and adjust the graph scale of the measured values with respect to time t.

You can enter the Minimum and Maximum values in the combo boxes.

Enter values in the Logging Interval and 1 Grid boxes to determine the scale (s/div) of the graph
display.

• 1 Grid

It sets the sampling number per grid of the graph.

Input range:  1 to 1000 samples

Monitor (Measured Values Display)

Load current IL and voltage Vc are displayed at approximately 2-second intervals.

Resistance R, reactance jX, impedance IZI, and phase angle  are synchronized to the logging
interval.

Status Display

The Load Current indicates the execution status of test.

The Impedance indicates the status of impedance measurement.

You can double-click the status box to open the Alarm Information dialog box.

*1 Load current status only
*2 Impedance status only

You can change these values even while the test is in progress (load on). However, avoid doing so as 
it places a heavy load on the PC.

θ

Status Description

Not connected FCTester for KFM2005 is started. (yellow)

Standby*1 A test is executable. (gray) 

Executing*1 A test is in progress. (green) 

Stopped*1 The stop button is pressed. (gray)

Rising*1 Load current is gradually increasing. (green)

Falling*1 Load current is gradually decreasing. (green)

Voltage stop The test stops at the off voltage. (yellow)

Error Communication error, etc. (red)

Load error An error occurs at the electronic load unit. (red)

OFF*2 Impedance measurement is off. (gray) 

ON*2 Impedance measurement is on. (green) 

Not measurable Measurements cannot be made due to over range, etc. (yellow)
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Constant Current Test

Result File

The result file (the Constant Current Test file) will be saved in the designated file.

p. 22
When the Auto Save is selected for the Result File Storage option, the name of file will be
"CC"+"Date"+"Time".

The data can be created in the text format by the TSV (Tab Separated Value).

The file for the constant current test can not be opened by the "FC Tester for KFM2005".

See

Measurement condition 

Measured data



22 FCTester for KFM2005

Option Settings

The following settings are available on the Option menu.

These settings are common to all of the I-V characteristic test, the Cole-Cole plot and the constant
current test.

• Result File Storage

• VISA Resource (Interface) Selection

• Load off when the load current at 0A

• Graph Setting

Result File Storage

Select Setup on the Options menu.

VISA Resource (Interface) Selection

Select Setup on the Options menu.

Select the VISA resource for the connection of measuring instruments. If the selected interface used
for the KFM2005 and the VISA resource are not corresponded, the communication is functioned
even when you click Connect in the Status, the status becomes Not connected. 

The drop-down box of VISA Resource Name of the Connected Instrument displays the available
VISA resource.

File Storage Setting Description

None The Result file is not created.

Manual Save Every time you click the Start, the dialog box displays to specify the file 
name and the folder for saving the result file.

Auto Save Every time you click the Start, the result file is created automatically with 
the following file name in the specified folder.
• I-V characteristics test: "IV" + "Date" + "Time"
• Cole-Cole plot: "COLE" + "Date" + "Time"
• Constant current test: "CC" + "Date" + "Time"
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Option Settings

The VISA resource string representation varies depending on the interface type (GPIB, ASRL, USB,
etc.). The table below gives typical examples.

In case of using RS232C (ASRL), the setting of the PC shall be as follows. Set the same condition for
the KFM2005.

• Bit rate: 19200 bps
• Data bits: 8 bits
• Flow control: OFF

Load off when the load current at 0A

Select Setup on the Options menu.

If you select the Load Off at 0 [A] check box, the load turns off when the load current setting is 0 A.

Resource String Description

GPIB0::3::INSTR Measuring instrument connected to GPIB0 with a 
primary address set to 3.

GPIB1::4::INSTR Measuring instrument connected to GPIB1 with a 
primary address set to 4.

ASRL1::INSTR Measuring instrument connected to serial port 1.

USB0::0x0B3E::0x1018::NJ003545::INSTR Measuring instrument connected to a USB port with 
vendor ID 2878 (hex 0B3E), product ID 4120 (hex 1018), 
and serial number NJ003545.

When the load turns on with the setting of 0 A, the load current IL operates like 0 A, but there exist 
an offset, so it can not go down to absolutely 0 A. The specification for the "offset" of the KFM2005 
shall be referred to within 2.5 mA (in 5 A range) or 0.5 mA (in 0.5 A range).
When you select Load Off at 0 [A] check box, the load current will be cut off electronically because 
of that the load turns off when the load current setting is 0 A. If you wish to set as low as 0 A, please 
use this option.
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Menu Reference

Graph Setting

Select Graph on the Options menu.

You can set the background and axes colors, the point size of data plots, and the width and color of
data lines.

Menu Reference

Menu Description

File Open... Opens the test result file. Sets the measurement conditions 
when the file is acquired, and displays the graph.
The test result file of the Constant Current Test can not be 
opened.

Exit Exit from FCTester for KFM2005.

Options Setup... Sets the saving file, VISA resource, and load off when the load 
current at 0 A.

Graph... Sets the background and axes colors, the point size of data plots, 
and the width and color of data lines.

Help About... Displays the version of FCTester for KFM2005.

Application Manual... Opens the FCTester for KFM2005 User's Manual.
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